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 Important Information

Warranty
The GPIB hardware is warranted against defects in materials and workmanship for a period of two years from the date of shipment, 
as evidenced by receipts or other documentation. National Instruments will, at its option, repair or replace equipment that proves 
to be defective during the warranty period. This warranty includes parts and labor. 

The media on which you receive National Instruments software are warranted not to fail to execute programming instructions, 
due to defects in materials and workmanship, for a period of 90 days from date of shipment, as evidenced by receipts or other 
documentation. National Instruments will, at its option, repair or replace software media that do not execute programming 
instructions if National Instruments receives notice of such defects during the warranty period. National Instruments does not 
warrant that the operation of the software shall be uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside of 
the package before any equipment will be accepted for warranty work. National Instruments will pay the shipping costs of 
returning to the owner parts which are covered by warranty.

National Instruments believes that the information in this document is accurate. The document has been carefully reviewed 
for technical accuracy. In the event that technical or typographical errors exist, National Instruments reserves the right to 
make changes to subsequent editions of this document without prior notice to holders of this edition. The reader should consult 
National Instruments if errors are suspected. In no event shall National Instruments be liable for any damages arising out of 
or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS ANY 
WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’S RIGHT TO RECOVER DAMAGES CAUSED BY FAULT OR 
NEGLIGENCE ON THE PART OF NATIONAL INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT THERETOFORE PAID BY THE CUSTOMER. NATIONAL 
INSTRUMENTS WILL NOT BE LIABLE FOR DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, OR INCIDENTAL OR 
CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY THEREOF. This limitation of the liability of National Instruments will 
apply regardless of the form of action, whether in contract or tort, including negligence. Any action against National Instruments 
must be brought within one year after the cause of action accrues. National Instruments shall not be liable for any delay in 
performance due to causes beyond its reasonable control. The warranty provided herein does not cover damages, defects, 
malfunctions, or service failures caused by owner’s failure to follow the National Instruments installation, operation, or 
maintenance instructions; owner’s modification of the product; owner’s abuse, misuse, or negligent acts; and power failure or 
surges, fire, flood, accident, actions of third parties, or other events outside reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical, including 
photocopying, recording, storing in an information retrieval system, or translating, in whole or in part, without the prior written 
consent of National Instruments Corporation.

Trademarks
CVI™, LabVIEW™, Measurement Studio™, National Instruments™, NI-488.2™ , and ni.com™ are trademarks of 
National Instruments Corporation.

Product and company names mentioned herein are trademarks or trade names of their respective companies.

WARNING REGARDING USE OF NATIONAL INSTRUMENTS PRODUCTS
(1) NATIONAL INSTRUMENTS PRODUCTS ARE NOT DESIGNED WITH COMPONENTS AND TESTING FOR A LEVEL 
OF RELIABILITY SUITABLE FOR USE IN OR IN CONNECTION WITH SURGICAL IMPLANTS OR AS CRITICAL 
COMPONENTS IN ANY LIFE SUPPORT SYSTEMS WHOSE FAILURE TO PERFORM CAN REASONABLY BE 
EXPECTED TO CAUSE SIGNIFICANT INJURY TO A HUMAN.

(2) IN ANY APPLICATION, INCLUDING THE ABOVE, RELIABILITY OF OPERATION OF THE SOFTWARE PRODUCTS 
CAN BE IMPAIRED BY ADVERSE FACTORS, INCLUDING BUT NOT LIMITED TO FLUCTUATIONS IN ELECTRICAL 
POWER SUPPLY, COMPUTER HARDWARE MALFUNCTIONS, COMPUTER OPERATING SYSTEM SOFTWARE 
FITNESS, FITNESS OF COMPILERS AND DEVELOPMENT SOFTWARE USED TO DEVELOP AN APPLICATION, 
INSTALLATION ERRORS, SOFTWARE AND HARDWARE COMPATIBILITY PROBLEMS, MALFUNCTIONS OR 
FAILURES OF ELECTRONIC MONITORING OR CONTROL DEVICES, TRANSIENT FAILURES OF ELECTRONIC 
SYSTEMS (HARDWARE AND/OR SOFTWARE), UNANTICIPATED USES OR MISUSES, OR ERRORS ON THE PART OF 
THE USER OR APPLICATIONS DESIGNER (ADVERSE FACTORS SUCH AS THESE ARE HEREAFTER 
COLLECTIVELY TERMED “SYSTEM FAILURES”). ANY APPLICATION WHERE A SYSTEM FAILURE WOULD 
CREATE A RISK OF HARM TO PROPERTY OR PERSONS (INCLUDING THE RISK OF BODILY INJURY AND DEATH) 
SHOULD NOT BE RELIANT SOLELY UPON ONE FORM OF ELECTRONIC SYSTEM DUE TO THE RISK OF SYSTEM 
FAILURE. TO AVOID DAMAGE, INJURY, OR DEATH, THE USER OR APPLICATION DESIGNER MUST TAKE 
REASONABLY PRUDENT STEPS TO PROTECT AGAINST SYSTEM FAILURES, INCLUDING BUT NOT LIMITED TO 
BACK-UP OR SHUT DOWN MECHANISMS. BECAUSE EACH END-USER SYSTEM IS CUSTOMIZED AND DIFFERS 
FROM NATIONAL INSTRUMENTS' TESTING PLATFORMS AND BECAUSE A USER OR APPLICATION DESIGNER 
MAY USE NATIONAL INSTRUMENTS PRODUCTS IN COMBINATION WITH OTHER PRODUCTS IN A MANNER NOT 
EVALUATED OR CONTEMPLATED BY NATIONAL INSTRUMENTS, THE USER OR APPLICATION DESIGNER IS 
ULTIMATELY RESPONSIBLE FOR VERIFYING AND VALIDATING THE SUITABILITY OF NATIONAL 
INSTRUMENTS PRODUCTS WHENEVER NATIONAL INSTRUMENTS PRODUCTS ARE INCORPORATED IN A 
SYSTEM OR APPLICATION, INCLUDING, WITHOUT LIMITATION, THE APPROPRIATE DESIGN, PROCESS AND 
SAFETY LEVEL OF SUCH SYSTEM OR APPLICATION.



 Compliance

FCC/Canada Radio Frequency Interference Compliance*

Determining FCC Class
The Federal Communications Commission (FCC) has rules to protect wireless communications from interference. 
The FCC places digital electronics into two classes. These classes are known as Class A (for use in industrial-
commercial locations only) or Class B (for use in residential or commercial locations). Depending on where it is 
operated, this product could be subject to restrictions in the FCC rules. (In Canada, the Department of 
Communications (DOC), of Industry Canada, regulates wireless interference in much the same way.)

Digital electronics emit weak signals during normal operation that can affect radio, television, or other wireless 
products. By examining the product you purchased, you can determine the FCC Class and therefore which of the two 
FCC/DOC Warnings apply in the following sections. (Some products may not be labeled at all for FCC; if so, the 
reader should then assume these are Class A devices.)

FCC Class A products only display a simple warning statement of one paragraph in length regarding interference and 
undesired operation. Most of our products are FCC Class A. The FCC rules have restrictions regarding the locations 
where FCC Class A products can be operated.

FCC Class B products display either a FCC ID code, starting with the letters EXN, 
or the FCC Class B compliance mark that appears as shown here on the right.

Consult the FCC web site http://www.fcc.gov for more information.

FCC/DOC Warnings
This equipment generates and uses radio frequency energy and, if not installed and used in strict accordance with the 
instructions in this manual and the CE Mark Declaration of Conformity**, may cause interference to radio and 
television reception. Classification requirements are the same for the Federal Communications Commission (FCC) 
and the Canadian Department of Communications (DOC). 

Changes or modifications not expressly approved by National Instruments could void the user’s authority to operate 
the equipment under the FCC Rules.

Class A
Federal Communications Commission

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 
of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the 
equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency 
energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to 
radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in 
which case the user will be required to correct the interference at his own expense.

Canadian Department of Communications
This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe A respecte toutes les exigences du Règlement sur le matériel brouilleur du 
Canada.

Class B
Federal Communications Commission

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 
of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a 
residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed 
and used in accordance with the instructions, may cause harmful interference to radio communications. However, 
there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful 
interference to radio or television reception, which can be determined by turning the equipment off and on, the user 
is encouraged to try to correct the interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.



• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

• Consult the dealer or an experienced radio/TV technician for help.

Canadian Department of Communications
This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le matériel brouilleur du 
Canada.

European Union - Compliance to EEC Directives
Readers in the EU/EEC/EEA must refer to the Manufacturer's Declaration of Conformity (DoC) for information** 
pertaining to the CE Mark compliance scheme. The Manufacturer includes a DoC for most every hardware product 
except for those bought for OEMs, if also available from an original manufacturer that also markets in the EU, or 
where compliance is not required as for electrically benign apparatus or cables.

* Certain exemptions may apply in the USA, see FCC Rules §15.103 Exempted devices, and §15.105(c). 
Also available in sections of CFR 47.

** The CE Mark Declaration of Conformity will contain important supplementary information and instructions 
for the user or installer.
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About This Manual

This manual contains instructions to help you install and configure the 

National Instruments GPIB-ENET and NI-488.2 for Windows Me/98/95.

This manual assumes that you are already familiar with 

Windows Me/98/95 and with TCP/IP networks, and that your computer is 

connected to an Ethernet network. Before you can use the driver software 

for the GPIB-ENET, you must install a Windows Sockets (WinSock) 

interface, 1.1 or higher. Microsoft provides a WinSock interface with 

Windows Me/98/95. You also can use a WinSock interface purchased from 

another network vendor.

Conventions Used in This Manual

This manual uses the following conventions:

» The » symbol leads you through nested menu items and dialog box options 

to a final action. The sequence File»Page Setup»Options directs you to 

pull down the File menu, select the Page Setup item, and select Options 

from the last dialog box.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to 

avoid injury, data loss, or a system crash.

This icon denotes a warning, which advises you of precautions to take to 

avoid being electrically shocked.

bold Bold text denotes items that you must select or click on in the software, 

such as menu items and dialog box options. Bold text also denotes 

parameter names and LED names.

bold italic Bold italic text is used in this manual to denote the default settings of the 

8-bit DIP switches.

IEEE 488, IEEE 488, IEEE 488.2, and IEEE 802.3 refer to the ANSI/IEEE Standard

IEEE 488.2, 488.1-1987, the ANSI/IEEE Standard 488.2-1992, and the ANSI/IEEE 

and IEEE 802.3 Standard 802.3, respectively, which define the GPIB.
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italic Italic text denotes variables, emphasis, a cross reference, or an introduction 

to a key concept. This font also denotes text that is a placeholder for a word 

or value that you must supply.

monospace Text in this font denotes text or characters that you should enter from the 

keyboard, sections of code, programming examples, and syntax examples. 

This font is also used for the proper names of disk drives, paths, directories, 

programs, subprograms, subroutines, device names, functions, operations, 

variables, filenames and extensions, and code excerpts.

monospace bold Bold text in this font denotes the messages and responses that the computer 

automatically prints to the screen.

Related Documentation

The following documents contain information that you might find helpful 

as you read this manual:

• ANSI/IEEE Standard 488.1-1987, IEEE Standard Digital Interface 

for Programmable Instrumentation

• ANSI/IEEE Standard 488.2-1992, IEEE Standard Codes, Formats, 

Protocols, and Common Commands

• ANSI/IEEE Standard 802.3-1988, Information Processing Systems, 

Local Area Networks, Part 3

Additionally, you might need to refer to the documentation provided by 

your WinSock vendor.
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1
Introduction

This chapter lists what you need to get started and optional equipment 

you can order, and briefly describes the GPIB-ENET hardware and the 

NI-488.2 software for Windows Me/98/95.

What You Need to Get Started

Before you install your GPIB hardware and the NI-488.2 software for 

Windows Me/98/95, make sure you have all of the following items:

❑ Windows Me/98/95 installed on your computer

❑ WinSock interface 1.1 or higher installed on your computer

❑ The NI-488.2 for Windows CD, which is included in your kit

❑ One of the following boxes, which is included in your kit:

– GPIB-ENET—10Base-T Version (100–120 VAC)

– GPIB-ENET—10Base-T Version (220–240 VAC)

– GPIB-ENET—Coax Version (100–120 VAC)

– GPIB-ENET—Coax Version (220–240 VAC)

❑ One of the following power cords, which is included in your kit:

– U.S. standard power cord

– Switzerland power cord

– Australian power cord

– Universal European power cord

– North American power cord

– U.K. power cord
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❑ One of the following Ethernet cables, which you can purchase from 

National Instruments:

– Twisted pair (10Base-T) straight-through cable (1, 5, or 10 m) for 

connecting the GPIB-ENET to a network hub

– Twisted pair (10Base-T) cross-over cable (1, 5, or 10 m) for 

connecting the GPIB-ENET directly to a computer’s network 

interface card (NIC)

– Coax (10Base-2) cables (1, 5, or 10 m)

– AUI (10Base-5) cables (1, 5, or 10 m)

❑ One of the following shielded GPIB cables, which you can purchase 

from National Instruments:

– Type X1 single-shielded cables (1, 2, or 4 m)

– Type X2 double-shielded cables (1, 2, or 4 m)

Caution To meet FCC emission limits for this device, you must use a shielded (Type X1 

or X2) GPIB cable. If you operate this equipment with a non-shielded cable, it may 

interfere with radio and television reception. 

Optional Equipment

This section lists optional equipment that you can order from National 

Instruments.

Optional Hardware
For information about ordering the following optional equipment, contact 

National Instruments:

• Serial or parallel bus extender and cables

• Bus expander/isolator

• GPIB mechanical switch

Multiple-Computer Software License
A multiple-computer software license allows one or more hosts on a single 

physical network to access one or more GPIB-ENET boxes. For 

information about ordering a software license, contact National 

Instruments.
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GPIB-ENET Hardware Overview

The GPIB-ENET hardware transparently handles data transfers between 

an Ethernet-based TCP/IP host and the GPIB. With the GPIB-ENET, 

multiple hosts can share a set of GPIB instruments or a single host can 

control several GPIB systems.

The GPIB-ENET uses the GPIB software to transform any computer 

with the GPIB driver and an Ethernet port into a fully functional GPIB 

Talker/Listener/Controller with complete communication and bus 

management capability. The GPIB-ENET is powered by an internal 

100–120 VAC or 220–240 VAC supply. 

The GPIB-ENET includes all the software and logic needed to implement 

the physical and electrical characteristics of all versions of IEEE 488, 

including IEEE 488.2, and IEEE 802.3. The GPIB-ENET interprets and 

executes commands that you send to it over an Ethernet link and performs 

all necessary Ethernet-to-GPIB protocol conversions. For more 

information about hardware specifications, refer to Appendix D, 

Specifications.

Figure 1-1 shows the seven light-emitting diodes (LEDs) on the 

GPIB-ENET top panel.

 

Figure 1-1.  GPIB-ENET Top Panel and LEDs

ETHERNET IEEE 488 Controller

Ethernet AUI
Connector

GPIB
Connector

Location of Coax or
10Base-T Connector

(Depending on Version)
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The LEDs show the current status of the GPIB-ENET. Table 1-1 describes 

each LED.

NI-488.2 Software Overview

The NI-488.2 software includes a native, 32-bit multitasking 

Windows Me/98/95 driver that is fully Plug and Play aware.

The NI-488.2 software supports the concurrent use of multiple types of 

GPIB hardware. For example, you can communicate with GPIB devices 

through an AT-GPIB/TNT, a PCMCIA-GPIB, and a GPIB-ENET in the 

same system at the same time. The NI-488.2 software is fully integrated 

into the operating system.

The NI-488.2 software, along with the GPIB hardware, transforms your 

computer into a GPIB Talker/Listener/Controller with complete 

communications and bus management capability. 

Table 1-1.  LED Descriptions

LED Description

POWER Indicates that power has been supplied to the unit and 

the ON/OFF switch is in the ON position.

READY Indicates that the box is ready for operation. 

Continuous flashing indicates an error occurred.

TALK Indicates that the GPIB-ENET is configured as a 

GPIB Talker.

LISTEN Indicates that the GPIB-ENET is configured as a 

GPIB Listener.

TRANSMIT Indicates that the GPIB-ENET is transmitting to 

the Ethernet network.

RECEIVE Indicates that the GPIB-ENET is receiving Ethernet 

network traffic.

LINK Indicates that the GPIB-ENET detected a twisted pair 

(10Base-T) link. For GPIB-ENET coax and AUI 

options, this LED remains OFF.
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The NI-488.2 software includes the following components:

• Device driver

• Measurement & Automation Explorer, which gives you access to the 

NI-488.2 development utilities, including the NI-488.2 Getting Started 

Wizard and the NI-488.2 Troubleshooting Wizard

• Language interface libraries for Microsoft Visual C/C++ 2.0 or higher, 

Borland C/C++ 4.0 or higher, and Microsoft Visual Basic 4.0 or higher

• Example programs that use the NI-488.2 API

Refer to Appendix D, Specifications, for information about the NI-488.2 

software transfer rates.

Time-Saving Development Tools

Your kit includes NI-488.2 for Windows Me/98/95. After you install your 

GPIB-ENET and NI-488.2, you can use standard GPIB I/O functions in 

LabVIEW and Measurement Studio with your GPIB interface. If you 

already have one or more of these applications and want to use them with 

your GPIB-ENET, refer to your product documentation for information 

about GPIB I/O functions. For ordering information, contact National 

Instruments.

LabVIEW is a graphical programming environment you can use to acquire 

data from thousands of different instruments, including IEEE 488.2 

devices, VXI devices, serial devices, PLCs, and plug-in data acquisition 

boards. After you acquire raw data, you can convert it into meaningful 

results using the data analysis routines in LabVIEW. The LabVIEW 

instrument drivers reduce software development time because you do not 

have to program the low-level control of each instrument.

Measurement Studio bundles LabWindows/CVI for C, and measurement 

tools for Microsoft Visual C++ and Microsoft Visual Basic. Measurement 

Studio is designed for building measurement and automation applications 

with the programming environment of your choice:

• LabWindows/CVI is an interactive ANSI C programming environment 

designed for building virtual instrument applications. 

LabWindows/CVI delivers a drag-and-drop editor for building user 

interfaces, a complete ANSI C environment for building your test 

program logic, and a collection of automated code generation tools, 

as well as utilities for building automated test systems, monitoring 

applications, or laboratory experiments.
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• Measurement Studio Tools for Visual C++ takes advantage of COM 

and ActiveX technologies to help you build measurement and 

automation applications. With the Visual C++ application wizard and 

instrument classes, you can use the IEEE 488.2 library to send and 

receive commands to and from instruments, and you can use VISA, 

an industry-standard I/O library, to communicate with GPIB, VXI, 

or serial devices using the same set of components.

• For Visual Basic programmers, Measurement Studio includes a 

collection of ActiveX controls designed for building virtual 

instrumentation systems. You can use the GPIB, serial, and VISA I/O 

controls and property pages to configure communication with your 

instruments.

The GPIB Analyzer is another optional tool available from National 

Instruments that is useful in troubleshooting a variety of IEEE 488 

hardware and software problems. With its built-in time-stamping 

capability, you can easily determine the throughput and overhead of 

your GPIB systems. The GPIB Analyzer software for Windows Me/98/95 

works with the AT-GPIB/TNT+ and PCMCIA-GPIB+ products, which 

provide GPIB Analyzer support along with the functionality of a 

high-performance GPIB Controller.
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2
Installation and Configuration

This chapter describes how to install and configure your GPIB-ENET and 

the NI-488.2 software for Windows Me/98/95.

Install the NI-488.2 Software

Before you install the GPIB-ENET hardware, complete the following steps 

to install the NI-488.2 software:

1. Insert the NI-488.2 for Windows CD.

2. When the NI-488.2 Software for Windows screen appears, click the 

Install NI-488.2 Software for Windows item, as shown in Figure 2-1.

Figure 2-1.  NI-488.2 Software for Windows CD Autorun Screen

The setup wizard guides you through the necessary steps to install the 

NI-488.2 software.
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After you install NI-488.2, install the GPIB-ENET. Continue to the next 

section, Add GPIB Hardware.

Add GPIB Hardware

Use the Add GPIB Hardware Wizard to inform Windows Me/98/95 that 

you are adding a GPIB-ENET to your system. To do so, complete the 

following steps:

1. Select Start»Programs»National Instruments»NI-488.2»Add 

GPIB Hardware.

2. When the wizard prompts you for a type of hardware, select 

GPIB-ENET and click Next to continue.

Figure 2-2.  Add GPIB Hardware Wizard Dialog Box

Restart Your System

Before you use the NI-488.2 software, you must restart your system.

When your system restarts, the NI-488.2 Getting Started Wizard launches 

automatically. Exit the NI-488.2 Getting Started Wizard. Later, you will be 

prompted to start the wizard again.



Chapter 2 Installation and Configuration

© National Instruments Corporation 2-3 GPIB-ENET for Windows Me/98/95

Configure and Install the Hardware

To configure the NI-488.2 software and your GPIB-ENET, complete the 

following steps.

Step 1. Determine IP and Ethernet Addresses
TCP/IP-based networks use the Internet Protocol (IP) address to route 

information to the appropriate network and host. If you are installing a 

GPIB-ENET in a network for the first time, or if your GPIB-ENET 

IP address changes, you must configure the IP address. To do so, 

complete the following steps:

1. Locate the Ethernet address on the baseplate label of the GPIB-ENET, 

as shown in Figure 2-3.

Note The Ethernet address is not the IP address. All devices on an Ethernet network 

are assigned a physical address—the Ethernet address—so they can communicate with 

each other.

Figure 2-3.  GPIB-ENET Baseplate Identification Label

2. Contact your network administrator to assign a unique, valid 

IP address or hostname for your GPIB-ENET. Your network 

administrator can determine whether the GPIB-ENET should have 

its IP address assigned by a RARP (Reverse Address Resolution 

Protocol) server, or configured manually, using the Assign IP 

Address utility.

3. Make a note of the IP address or hostname. You will use this 

information in the following steps.

Serial No. XXXXXX

Model:  GPIB-ENET

P/N  1819XX-XX REV X

Ethernet: 00:80:2F:FF:XX:XXMADE IN U.S.A.

XXXV 50-60HZ XXmA FUSE:  XXXmA SLOW   250V

Serial No. XXXXXX

Ethernet Address

AC Input
Voltage

Frequency

Current
Fuse Information
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Step 2. Configure the NI-488.2 Software
To configure the NI-488.2 software, complete the following steps:

1. Select Start»Programs»National Instruments»NI-488.2»Explore 

GPIB to start the Measurement & Automation Explorer.

2. Under Measurement & Automation, expand the Devices and 

Interfaces folder.

3. Right-click the GPIB-ENET item and select Properties from the 

drop-down menu that appears.

4. To configure the network addresses assigned to your GPIB-ENET, 

complete the following steps:

a. Click the Network Settings tab.

b. Type the IP address reserved by your network administrator in the 

IP Address field, as shown in Figure 2-4.

Figure 2-4.  Network Settings Tab
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The NI-488.2 Configuration utility context-sensitive online help contains 

all of the information that you need to configure the NI-488.2 software 

properly. To view the online help, click on the question mark (?) button in 

the toolbar and click on any item about which you want more information.

Step 3. Configure the GPIB-ENET Operating Characteristics
The GPIB-ENET has a two-position slide switch that you use to configure 

the network interface connector. The GPIB-ENET also has an 8-bit DIP 

switch that you use to configure the operating characteristics. These 

switches are located on the back panel of the GPIB-ENET, as shown in 

Figure 2-5.

To configure the GPIB-ENET operating characteristics, refer to the 

following sections.

Figure 2-5.  GPIB-ENET Back Panel Switches

Configure the Slide Switch
The GPIB-ENET has two network interface connectors: a 15-pin AUI 

connector, and either a 10Base-T or coax Ethernet connector.

Use the slide switch to select the connector that the GPIB-ENET uses. The 

default switch setting is either 10Base-T or COAX, as shown in Figure 2-6. 

Figure 2-6.  Default Switch Setting for Ethernet Port Configuration

If you want to use the AUI connector, slide the switch setting to AUI, 

as shown in Figure 2-7.

10BASE-T AUI

8 7 6 5 4 3 2 1 ON

10Base-T

COAX

OR

AUI

AUI
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Figure 2-7.  Switch Setting for AUI Ethernet Port Configuration

Verify the 8-Bit DIP Switch Setting
The 8-bit DIP switch sets the operating mode of the GPIB-ENET. The 

default switch setting is for normal operation mode. In normal operation 

mode, all the switches are in the OFF position.

Verify that all the DIP switches on your GPIB-ENET are in the OFF 

position. Do not change the DIP switch settings unless you run a utility that 

prompts you to do so. For more information about the 8-bit DIP switch, 

refer to Appendix A, GPIB-ENET 8-Bit DIP Switch.

Step 4. Connect the Cables

Note If you do not have an Ethernet cable, as listed in the What You Need to Get Started 

section of Chapter 1, Introduction, contact National Instruments for ordering information.

To connect your cables, complete the following steps:

1. Connect one end of your Ethernet cable to your GPIB-ENET and 

securely fasten it. Connect the other end of the Ethernet cable to your 

Ethernet network. Make sure that you comply with all IEEE 802.3 

cabling restrictions.

2. Plug the power cord into an AC outlet of the correct voltage.

Caution Do not operate your GPIB-ENET at any voltage other than the one specified on 

your GPIB-ENET baseplate label. Doing so could damage the GPIB-ENET.

Note Do not connect GPIB devices to your GPIB port until after you run the NI-488.2 

Troubleshooting Wizard as described in Chapter 3, Verify the Installation.

10Base-T

COAX

OR

AUI

AUI
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Step 5. Switch on Your GPIB-ENET
The GPIB-ENET has either a 100–120 VAC or 220–240 VAC power 

supply. Before you use your GPIB-ENET, verify that the voltage rating 

listed on the baseplate label matches the voltage that is supplied in your 

area. To see an illustration of the baseplate label, refer to Figure 2-3.

Contact your network administrator to determine whether the IP address 

is assigned by a RARP server or must be assigned manually. After you 

contact your network administrator, refer to the following sections for 

instructions on how to assign the IP address.

Assign IP Address with a RARP Server
To assign the IP address with a RARP server, power on your GPIB-ENET. 

The POWER LED comes on immediately. The READY LED flashes 

while the GPIB-ENET completes its power-on self tests and assigns the IP 

address. When the READY LED remains steady, the GPIB-ENET is ready 

to operate.

Note The power-on self tests take about 10 seconds to complete. The time required for 

the IP address assignment is dependent on your network and the configuration of your 

GPIB-ENET. If the READY LED continues to flash for more than one minute, refer to 

the Troubleshooting Hardware Problems section in Appendix C, Troubleshooting and 

Common Questions.

Assign IP Address with the Assign IP Address Utility
If your network administrator tells you to assign the IP address manually, 

run the Assign IP Address utility. To do so, complete the following steps:

1. Select Start»Programs»National Instruments»NI-488.2»Explore 

GPIB to start the Measurement & Automation Explorer.

2. Under Measurement & Automation, expand the Devices and 

Interfaces folder.

3. Right-click the GPIB-ENET item and select Assign IP Address from 

the drop-down menu that appears.

To view the built-in, context-sensitive online help for the Assign IP Address 

utility, click the Help button.
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Step 6. Configure Advanced IP Settings
Before you use your GPIB-ENET for your application, you can use the 

Advanced IP Settings utility to configure the proper subnet information. 

Your GPIB-ENET may work properly if you skip this step, but National 

Instruments recommends that you configure the proper subnet information, 

including the broadcast IP address and netmask, and up to four router 

IP addresses. Contact your network administrator for this information.

To configure the proper subnet information with the Advanced IP Settings 

utility, complete the following steps:

1. Select Start»Programs»National Instruments»NI-488.2»Explore 

GPIB to start the Measurement & Automation Explorer.

2. Under Measurement & Automation, expand the Devices and 

Interfaces folder.

3. Right-click the GPIB-ENET item and select Advanced IP Settings 

from the drop-down menu that appears.

To view the built-in, context-sensitive online help for the Advanced 

IP Settings utility, click the Help button.

After you configure the software and hardware, continue to Chapter 3, 

Verify the Installation.
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3
Verify the Installation

This chapter describes how to verify the hardware and software installation.

Power-On Self Tests

When you power on your GPIB-ENET, the POWER LED comes on 

immediately. The READY LED flashes while the GPIB-ENET completes 

its power-on self tests and assigns an IP address. 

The power-on self tests take about 10 seconds to complete. The time 

required for the IP address assignment is dependent on your network and 

the configuration of your GPIB-ENET. When the tests are successful and 

the IP address is assigned, the READY LED remains steady, indicating 

that the GPIB-ENET is ready to operate.

If the READY LED continues to flash for more than one minute, refer to 

the Troubleshooting Hardware Problems section in Appendix C, 

Troubleshooting and Common Questions.

Run the NI-488.2 Getting Started Wizard

To test the hardware and software installation, run the NI-488.2 Getting 

Started Wizard. Select Start»Programs»National Instruments»

NI-488.2»Getting Started and follow the instructions on the screen.

The NI-488.2 Getting Started Wizard, shown in Figure 3-1, verifies the 

hardware and software installation and helps you begin to communicate 

with your GPIB instruments.
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Figure 3-1.  NI-488.2 Getting Started Wizard Dialog Box

When you click Verify your hardware and software installation, the 

NI-488.2 Troubleshooting Wizard tests your GPIB interface and displays 

the results, as shown in as shown in Figure 3-2.

Note The GPIB cable must be disconnected from your GPIB interface before you run the 

NI-488.2 Troubleshooting Wizard.

Figure 3-2.  NI-488.2 Troubleshooting Wizard

To view online help for the Troubleshooting Wizard, click the Help button. 

Also refer to Appendix C, Troubleshooting and Common Questions.



Chapter 3 Verify the Installation

© National Instruments Corporation 3-3 GPIB-ENET for Windows Me/98/95

Connecting the GPIB Cable

When you finish verifying the installation, you can connect the GPIB cable 

to your GPIB-ENET.

Note If you do not have a GPIB cable, as listed in the What You Need to Get Started 

section of Chapter 1, Introduction, contact National Instruments for ordering information.

Connect one end of your GPIB cable to your GPIB-ENET and tighten the 

thumb screws on the connector. Connect the other end of your GPIB cable 

to your GPIB system. Make sure you comply with all IEEE 488.1 cabling 

restrictions and use only shielded GPIB cables.
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4
Begin to Use the 
NI-488.2 Software

This chapter helps you get started with the NI-488.2 software.

Getting Started

The NI-488.2 Getting Started Wizard helps you get started with GPIB 

instrument communication using the Measurement & Automation 

Explorer. To run the NI-488.2 Getting Started Wizard, select 

Start»Programs»National Instruments»NI-488.2»Getting Started.

After the NI-488.2 Getting Started Wizard runs the NI-488.2 

Troubleshooting Wizard to verify the installation, click Communicate 

with your instrument. The Getting Started Wizard then steps you through 

communicating with your GPIB instruments via the Measurement & 

Automation Explorer.

Figure 4-1.  Communicating with Your Instrument
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A
GPIB-ENET 8-Bit DIP Switch

This appendix describes how the 8-bit DIP switch on the back panel affects 

the operation of the GPIB-ENET.

The 8-bit DIP switch is located on the back panel of the GPIB-ENET, as 

shown in Figure A-1. The DIP switches are used to set the operation mode 

of the GPIB-ENET. The default switch setting is for normal operation 

mode; all the switches are in the OFF position.

Figure A-1.  GPIB-ENET Back Panel Switches

8-Bit DIP Switch Descriptions

Table A-1 shows the possible settings of the GPIB-ENET DIP switches and 

what each setting indicates. Default settings are in bold italics.

Table A-1.  DIP Switch Settings

Switch Position Indication

8 ON Extended Factory Test

OFF Normal Operation

7 ON Modify Mode

OFF Normal Operation

6 ON* Use Stored IP Address

OFF Obtain IP Address

10BASE-T AUI

8 7 6 5 4 3 2 1 ON
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Switch 8
This switch puts your GPIB-ENET in Extended Factory Test mode. In 

normal operating mode, switch 8 should be in the OFF position.

When this switch is in the ON position, the GPIB-ENET performs extended 

tests that require special connections to the GPIB and Ethernet ports. 

Without these connections, the GPIB-ENET cannot pass the extended 

factory tests.

Switch 7
This switch puts your GPIB-ENET in Modify Mode. In normal operating 

mode, switch 7 should be in the OFF position.

The firmware controlling your GPIB-ENET is stored in EEPROM. When 

switch 7 is in the ON position, you can reprogram the firmware memory 

from the Ethernet network using the Update Firmware utility.

Note Before you update the firmware, your GPIB-ENET must already be configured for 

your subnet with a valid IP address, as described in Step 2. Configure the NI-488.2 

Software, in Chapter 2, Installation and Configuration.

The GPIB-ENET always ships with the most recent firmware. You do not 

need to run the firmware update utility on a new product. You can obtain 

the latest upgrade at the following path:

ftp://ftp.ni.com/support/gpib/firmware/GPIBENET/

With switch 7 in the ON position, complete the following steps to start the 

Update Firmware utility:

1. Select Start»Programs»National Instruments»NI-488.2»Explore 

GPIB to start the Measurement & Automation Explorer.

5 ON Manual IP Assignment

OFF Automatic IP Assignment

1–4 OFF These switches are reserved and should 

remain OFF.

* When switch 6 is in the ON position, switch 5 is ignored.

Table A-1.  DIP Switch Settings (Continued)

Switch Position Indication



Appendix A GPIB-ENET 8-Bit DIP Switch

© National Instruments Corporation A-3 GPIB-ENET for Windows Me/98/95

2. Under Measurement & Automation, expand the Devices and 

Interfaces folder.

3. Right-click the GPIB-ENET item and select Update Firmware from 

the drop-down menu that appears.

Caution Do not power-off the GPIB-ENET or disconnect the power supply while running 

the Update Firmware utility. Doing so will damage the unit.

When the GPIB-ENET finishes updating the firmware, the READY LED 

flashes a slow pattern.

To view the built-in, context-sensitive online help for the utility, click the 

Help button.

Switch 6
This switch sets how the IP address is determined when you power on 

the GPIB-ENET. When switch 6 is in the OFF position, the GPIB-ENET 

receives the IP address from the network. Each time the GPIB-ENET 

receives the IP address from the network, the GPIB-ENET stores it in 

nonvolatile memory. When switch 6 is in the ON position, the GPIB-ENET 

retrieves the IP address that is stored in nonvolatile memory.

When switch 6 is in the ON position, the setting of switch 5 is ignored.

Switch 5
This switch sets how the GPIB-ENET configures IP addresses. When 

switch 5 is in the OFF position, the GPIB-ENET issues Reverse Address 

Resolution Protocol (RARP) requests each time you power it on. The 

GPIB-ENET continues to issue RARP requests until it receives a valid 

RARP reply. If switch 5 is in the ON position, the GPIB-ENET does not 

issue RARP requests.

In most networks, the GPIB-ENET can use RARP to configure its 

IP address automatically; however, some networks, for security or other 

reasons, do not use RARP. If your network does not use RARP, you must 

manually configure the IP address. To do so, run the Assign IP Address 

utility, as described in the Assign IP Address with the Assign IP Address 

Utility section in Chapter 2, Installation and Configuration.

When switch 6 is in the ON position, the setting of switch 5 is ignored.
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Switches 1–4
These switches are reserved for future expansion. They should remain in 

the OFF position.
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B
READY LED Signaling

This appendix describes how to interpret the READY LED error codes.

Overview

The READY LED has several purposes on the GPIB-ENET. When 

you power on the GPIB-ENET, the READY LED flashes while the 

GPIB-ENET completes its power-on self tests. When the tests successfully 

complete and the IP address is assigned, the READY LED remains steady, 

indicating that the GPIB-ENET is ready to operate.

Note The power-on self tests take about 10 seconds to complete. The time required for 

the IP address assignment is dependent on your network and the configuration of your 

GPIB-ENET. If the READY LED continues to flash for more than one minute, refer to 

the Troubleshooting Hardware Problems section in Appendix C, Troubleshooting and 

Common Questions.

Troubleshooting a Slowly Blinking READY LED

During operation, the READY LED might blink slowly. This occurs after 

you run the Update Firmware utility, while the GPIB-ENET reports status 

on the operation. At other times, the READY LED blinks slowly in a 

recognizable pattern to alert you of GPIB-ENET internal errors.

Recording the READY LED Pattern
READY LED signaling can report up to 100 different errors. The errors 

are reported through sequences of READY LED flashes. A three-second 

interval, during which the READY LED is OFF, separates each repetition 

of the sequence. Interpret and record the signal pattern as described in this 

section.

Note By recording the READY LED status messages before calling National 

Instruments, you can save yourself time, and the Product Support Department can 

answer your questions more accurately and efficiently. Do not switch off power to your 

GPIB-ENET before recording the flashing READY LED pattern.
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To record the pattern, complete the following steps:

1. Do not switch off power to your GPIB-ENET.

2. Count the number of long one-second flashes—that is, one second ON, 

one second OFF. The long flashes appear in sets of one to ten.

3. Count the number of short flashes after the long flashes; each short 

flash lasts about one-fifth of a second. Flashes occur in sets of one to 

ten.

4. Make a note of the READY LED pattern.

5. Refer to Appendix E, Technical Support Resources, and contact 

National Instruments.

You can try to resolve the problem by completing the following steps:

1. Verify that all of your Ethernet cables are attached securely.

2. Turn your GPIB-ENET off and wait five seconds.

3. Turn your GPIB-ENET on and wait to see if the READY LED is still 

blinking slowly.
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C
Troubleshooting and 
Common Questions

This appendix describes how to troubleshoot problems and answers some 

common questions.

Troubleshooting Hardware Problems

Warning Do not try to open and service the box unless you are qualified personnel and 

equipped to do so. The GPIB-ENET contains circuitry that operates under hazardous 

voltages.

To troubleshoot problems with your GPIB-ENET, complete the following 

steps:

1. Make sure that all cables are securely connected to the GPIB-ENET.

2. Make sure that the GPIB-ENET is powered on. If the unit is powered 

on and plugged into an outlet of the proper voltage, but you see no LED 

activity, check the condition of the fuse. For fuse specifications, refer 

to Appendix D, Specifications.

Warning To prevent fire, replace the fuse with only the same type and rating of fuse. 

For fuse specifications, refer to Appendix D, Specifications.

3. Make sure that the Ethernet port configuration slide switch is set to the 

correct Ethernet port. For more information, refer to the Configure the 

Slide Switch section in Chapter 2, Installation and Configuration.

4. Make sure that the DIP switch settings are configured properly for your 

system. For more information, refer to Appendix A, GPIB-ENET 8-Bit 

DIP Switch.
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5. Verify your IP address, as follows:

a. Verify with your network administrator that your IP address is 

valid and that the network is set up to recognize the IP address 

properly.

b. If you configured the IP address manually using the Assign 

IP Address utility, make sure that you followed the instructions in 

the online help.

READY LED Problems
If the READY LED continues to flash for more than one minute, you have 

a problem with your setup. If the READY LED flashes quickly, the 

GPIB-ENET cannot obtain its IP address from the network. In this case, 

check with your network administrator to verify your IP address and make 

sure that you recorded the Ethernet address correctly.

If the READY LED is blinking slowly, refer to Appendix B, READY LED 

Signaling, for instructions on how to record the READY LED pattern.

Troubleshooting Problems

To troubleshoot problems with the NI-488.2 software, start 

the Measurement & Automation Explorer by selecting Start»

Programs»National Instruments»NI-488.2»Explore GPIB. Within 

the Measurement & Automation Explorer, select Help»Troubleshooting»

NI-488.2 Troubleshooting Wizard to start the NI-488.2 Troubleshooting 

Wizard.

Note The GPIB cable must be disconnected from your GPIB interface before you run the 

NI-488.2 Troubleshooting Wizard.

Troubleshooting EDVR Error Conditions

In some cases, calls to the NI-488.2 API may return with the ERR bit set in 

ibsta and the value EDVR in iberr. You can use the value stored in 

ibcntl to troubleshoot the error condition. If you receive an EDVR error 

condition, refer to the following sections to troubleshoot the error 

condition.
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EDVR Error Condition with ibcntl Set to 0xE028002C (-534249428)
If a call is made with a board number that is within the allowed range 

(typically 0 to 3), but the board has not been assigned to a GPIB interface, 

an EDVR error condition occurs with ibcntl set to 0xE028002C. To 

assign the board number to a GPIB interface, configure the NI-488.2 

software and select an interface name. For instructions on how to do so, 

refer to the Configure and Install the Hardware section in Chapter 2, 

Installation and Configuration.

EDVR Error Condition with ibcntl Set to 0xE0140025 (-535560155)
If a call is made with a board number that is not within the allowed range 

(typically 0 to 3), an EDVR error condition occurs with ibcntl set to 

0xE0140025. To solve this problem, change the board number to one 

within the allowed range. For instructions on how to do so, refer to the 

Configure and Install the Hardware section in Chapter 2, Installation and 

Configuration.

EDVR Error Condition with ibcntl Set to 0xE0140035 (-535560139)
If a call is made with a device name that is not listed in the logical device 

templates that are part of the NI-488.2 Configuration utility, an EDVR error 

condition occurs with ibcntl set to 0xE0140035. To solve this problem, 

rename the device template, as follows:

1. Select Start»Settings»Control Panel.

2. Double-click on the System icon.

3. Select the Device Manager tab and click on the View devices by type 

button.

4. Click on the National Instruments GPIB Interfaces icon.

5. Click on the Properties button.

6. Select the Device Templates tab and rename the device template as 

described in your application documentation.

7. Click on the OK button twice to save your changes and exit.

EDVR Error Conditions with ibcntl in the Range of 0xE1002710 
(-520083696) to 0xE1002EE0 (-520081696)

The WinSock interface returns errors in the range of 0xE1002710 to 

0xE1002EE0. The lower 16 bits of ibcntl specify the actual WinSock 

interface error. For more information about the specific error, refer to your 

WinSock interface documentation.
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EDVR Error Condition with ibcntl set to 0xE1030043 (-519897021) 
If you enabled DOS NI-488.2 support and tried to run an existing DOS 

NI-488.2 application that was compiled with an older, unsupported DOS 

language interface, an EDVR error condition occurs with ibcntl set to 

0xE1030043.

Missing WinSock Support

If you have not enabled and configured WinSock support, complete the 

following steps:

1. Select Start»Settings»Control Panel.

2. Double-click the Network icon.

For Windows Me, if you do not see the Network icon, select view all 

Control Panel options on the left side of the window.

3. In the Network dialog box, click the Configuration tab and 

click Add.

4. In the Select Network Component Type dialog box, select Protocol 

from the list box and click Add.

5. In the Select Network Protocol dialog box, select the appropriate 

Manufacturers and Network Protocols from the list boxes.

Because many different network providers and protocols are available 

in this dialog box, consult your network provider documentation to 

determine which protocol provides WinSock support from that vendor. 

For example, to enable Microsoft WinSock support, select Microsoft 

in the Manufacturers list box and TCP/IP in the Network Protocols 

list box. For instructions on how to configure the selected protocol, 

consult your network provider documentation.

6. Click OK.

7. After you enable and configure WinSock support, run the NI-488.2 

Troubleshooting Wizard. To do so, start the Measurement & 

Automation Explorer by selecting Start»Programs»National 

Instruments»NI-488.2»Explore GPIB. Within the Measurement & 

Automation Explorer, select Help»Troubleshooting»NI-488.2 

Troubleshooting Wizard.
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Common Questions

I do not have a WinSock interface installed. How do I install a WinSock 

interface?

Before you use the driver software for the GPIB-ENET, you must install a 

WinSock interface, 1.1 or higher. You can install a WinSock interface from 

Microsoft or another network vendor. For instructions on how to install and 

configure WinSock support, refer to the Missing WinSock Support section 

earlier in this appendix.

My driver is not communicating with the GPIB-ENET. What should 

I do? 

Make sure that your GPIB-ENET is configured properly. For instructions 

on how to configure your GPIB-ENET, refer to the Configure and Install 

the Hardware section in Chapter 2, Installation and Configuration.

My I/O worked with a board interface, but it times out when I use the 

GPIB-ENET interface. What should I do? 

Network communication is slower than straight cable 

communication.You might need to raise the default Timeout value.

1. Select Start»Programs»National Instruments»NI-488.2»Explore 

GPIB to start the Measurement & Automation Explorer.

2. Under Measurement & Automation, expand the Devices and 

Interfaces folder.

3. Right-click on the GPIB-ENET/100 item and select Properties from 

the drop-down menu that appears.

4. Click on the NI-488.2 Settings tab and change the I/O Timeout 

setting.

I powered off my GPIB-ENET before recording the flashing READY 

LED pattern. What should I do? 

Before you contact National Instruments, try to duplicate the error. 

Recording the READY LED pattern is not critical to the operation of your 

GPIB-ENET, but it saves you time and helps National Instruments diagnose 

the problem quickly and accurately.
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How many GPIB interfaces can I configure for use with the NI-488.2 

software? 

You can configure the NI-488.2 software to communicate with up to 

100 GPIB interfaces.

How many devices can I configure for use with the NI-488.2 software? 

You can configure the NI-488.2 software to use up to 1,024 logical devices. 

The default number of devices is 32. The maximum number of physical 

devices you should connect to a single GPIB interface is 14, or fewer, 

depending on your system configuration.

How can I determine if my GPIB hardware and the NI-488.2 software 

are installed properly?

Run the NI-488.2 Getting Started Wizard by selecting Start»Programs»

National Instruments»NI-488.2»Getting Started.
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D
Specifications

This appendix lists the electrical, physical, and environmental 

characteristics of the GPIB-ENET hardware and the transfer rates of 

the GPIB software, along with the recommended operating conditions.

Electrical Characteristics
Power supply unit

100–120 VAC ................................. ±10%, 50–60 Hz

220–240 VAC ................................. ±10%, 50–60 Hz

Maximum current requirement

100–120 VAC ................................. 110 mA

220–240 VAC ................................. 55 mA

Fuse rating and type

100–120 VAC ................................. 300 mA, UL/CSA approved

220–240 VAC ................................. 500 mA, IEC approved

Environmental Characteristics
Operating temperature............................ 0° to 40° C

Storage temperature ............................... –20° to 70° C

Relative humidity ................................... 10% to 90%, noncondensing

EMI ........................................................ FCC Class A Verified



Appendix D Specifications

GPIB-ENET for Windows Me/98/95 D-2 ni.com

Physical Characteristics
Overall case size (dimensions) ...............8.89 by 14.35 by 4.11 cm

(3.5 by 5.65 by 1.62 in.)

Case material ..........................................All metal enclosure

Weight ....................................................0.41 kg (0.9 lb) 

GPIB Software Transfer Rate for the GPIB-ENET
3-wire (IEEE 488) ..................................Over 70 kbytes/s1

1   Actual speed may vary considerably from speed shown because of system and instrumentation capabilities.
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E
Technical Support Resources

Web Support

National Instruments Web support is your first stop for help in solving 

installation, configuration, and application problems and questions. Online 

problem-solving and diagnostic resources include frequently asked 

questions, knowledge bases, product-specific troubleshooting wizards, 

manuals, drivers, software updates, and more. Web support is available 

through the Technical Support section of ni.com. You also can contact our 

application engineers by visiting ni.com/ask and filling out an e-mail 

request form.

NI Developer Zone

The NI Developer Zone at ni.com/zone is the essential resource for 

building measurement and automation systems. At the NI Developer Zone, 

you can easily access the latest example programs, system configurators, 

tutorials, technical news, as well as a community of developers ready to 

share their own techniques.

Customer Education

National Instruments provides a number of alternatives to satisfy your 

training needs, from self-paced tutorials, videos, and interactive CDs to 

instructor-led hands-on courses at locations around the world. Visit the 

Customer Education section of ni.com for online course schedules, 

syllabi, training centers, and class registration.

System Integration

If you have time constraints, limited in-house technical resources, or other 

dilemmas, you may prefer to employ consulting or system integration 

services. You can rely on the expertise available through our worldwide 

network of Alliance Program members. To find out more about our 

Alliance system integration solutions, visit the System Integration section 

of ni.com.
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Worldwide Support

National Instruments has offices located around the world to help address 

your support needs. You can access our branch office Web sites from the 

Worldwide Offices section of ni.com. Branch office Web sites provide 

up-to-date contact information, support phone numbers, e-mail addresses, 

and current events.

If you have searched the technical support resources on our Web site and 

still cannot find the answers you need, contact your local office or National 

Instruments corporate. Phone numbers for our worldwide offices are listed 

at the front of this manual.
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Glossary

Prefix Meanings Value

m- milli- 10–3

c- centi- 10–2

k- kilo- 103

M- mega- 106

° degrees

% percent

A amperes

AC alternating current

ANSI American National Standards Institute

AUI attachment unit interface

C Celsius

CSA Canadian Standards Association

DIP dual inline package

DLL dynamic link library

EEPROM electrically erasable programmable read-only memory

EMI electromagnetic interference

FCC Federal Communications Commission

g grams

GPIB General Purpose Interface Bus

Hz hertz

IEC International Electrotechnical Commission

IEEE Institute of Electrical and Electronic Engineers

in. inches
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IP Internet Protocol

lb pounds

LED light-emitting diode

m meters

MB megabytes of memory

PC personal computer

RAM random-access memory

RARP Reverse Address Resolution Protocol

s seconds

TCP Transmission Control Protocol

TCP/IP Transmission Control Protocol/Internet Protocol

UL Underwriters Laboratories

V volts

VAC volts alternating current
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8-bit DIP switch, 2-6, A-1

A
advanced IP settings, 2-8

assign IP address, 2-7

C
cables

Ethernet connection, 2-6

GPIB connection, 3-3

power connection, 2-6

caution

using firmware update utility, A-3

common questions, C-1

communicating with GPIB-ENET, C-5

network communication and GPIB-ENET, 

C-5

software, C-2, C-6

troubleshooting EDVR error conditions, 

C-2

Winsock interface, C-5

configuration

advanced IP settings, 2-8

default slide switch setting (figure), 2-5

IP address utility, 2-7

slide switch, 2-5

slide switch setting for AUI Ethernet port 

configuration (figure), 2-6

verify the 8-bit DIP switch setting, 2-6

configuration and installation, 2-1

connecting

Ethernet cable, 2-6

GPIB cable, 2-6, 3-3

GPIB devices (caution), 2-6

power cable, 2-6

customer education, E-1

D
documentation

conventions used in this manual, xi

related documentation, xii

E
EDVR error conditions, C-2

F
firmware update utility

important warning, A-3

upgrade location, A-2

G
getting started, 1-1

getting started wizard, 3-1, 3-2

dialog box, 3-2

GPIB cable

connecting, 2-6, 3-3

GPIB-ENET

8-bit DIP switch, A-1

descriptions, A-1

switch 5, A-3

switch 6, A-3

switch 7, A-2

switch 8, A-2

switches 1-4, A-4

back panel switches, 2-5, A-1

baseplate identification label (figure), 2-3

common questions, C-5
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configure operating characteristics, 2-5

configure the slide switch, 2-5

default slide switch setting (figure), 2-5

DIP switch settings (table), A-1

hardware overview, 1-3

IP address utility, 2-7

RARP server, 2-7

slide switch setting for AUI Ethernet port 

configuration (figure), 2-6

top panel and LEDs (figure), 1-3

troubleshootring network 

communication, C-5

verify the 8-bit DIP switch setting, 2-6

H
hardware

8-bit back panel switches, A-1

8-bit DIP switch, A-1

descriptions, A-1

switch 5, A-3

switch 6, A-3

switch 7, A-2

switch 8, A-2

switches 1-4, A-4

add GPIB hardware, 2-2

advanced IP settings, 2-8

back panel switches, 2-5

configure and install, 2-3

configure the slide switch, 2-5

default slide switch setting (figure), 2-5

DIP switch settings (table), A-1

GPIB-ENET baseplate identification 

label (figure), 2-3

IP address utility, 2-7

overview, 1-3

RARP server, 2-7

slide switch setting for AUI Ethernet port 

configuration (figure), 2-6

troubleshooting, C-1

verify the 8-bit DIP switch setting, 2-6

I
installation

GPIB cable, 3-3

installation and configuration, 2-1

hardware, configure and install, 2-3

verification, 3-1

introduction, 1-1

IP address utility, 2-7

L
LEDs

READY LED signaling, B-1

recording the READY LED pattern, B-1

top panel and LEDs (figure), 1-3

troubleshooting, B-1, C-2

M
missing Winsock support, C-4

N
National Instruments Web support, E-1

NI Developer Zone, E-1

NI-488.2 software

begin to use, 4-1

communicating with your instrument 

(figure), 4-1

configuration, 2-4

getting started wizard, 3-1

dialog box, 3-2

installation, 2-1

network settings tab (figure), 2-4

overview, 1-4

troubleshooting, C-6

troubleshooting EDVR error conditions, 

C-2

troubleshooting wizard, C-2

troubleshooting wizard (figure), 3-2, C-2
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optional equipment, 1-2

P
power-on self tests, 3-1

R
RARP server

assigning IP address, 2-7

READY LED signaling

overview, B-1

recording the READY LED pattern, B-1

troubleshooting, B-1, C-2

rebooting

after firmware update, A-3

related documentation, xii

S
software

add GPIB hardware, 2-2

autorun screen (figure), 2-1

begin to use, 4-1

communicating with your instrument 

(figure), 4-1

configuration, 2-4

development tools, 1-5

getting started wizard, 3-1

dialog box, 3-2

installation, 2-1

license for multiple computer, 1-2

network settings tab (figure), 2-4

overview, 1-4

troubleshooting, C-2, C-6

troubleshooting EDVR error conditions, 

C-2

troubleshooting wizard (figure), 3-2

specifications, D-1

system integration, by National Instruments, 

E-1

T
technical support resources, E-1

top panel and LEDs (figure), 1-3

troubleshooting, C-1

EDVR error conditions, C-2

software, C-2, C-6

troubleshooting wizard (figure), 3-2

V
verify the installation, 3-1

voltage warning, 2-6

W
Web support from National Instruments, E-1

what you need to get started, 1-1

Windows

missing Winsock support, C-4

worldwide technical support, E-2
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